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This guide outlines SIS integration within Impero Education Pro.

e End users can request to connect with Impero through their Clever Portal
alternatively Impero can Invite School Districts to connect their Impero
Server to Clever,

e There is no cost associated with using Clever SIS integration for the
school district.

e Impero will support the connection of Impero to Clever and Clever will
support the School district with the administration of their Clever portal
(including sharing rules)

e (lever use the term ‘sections’ to refer to groups of students or classes
and Impero create ‘User Groups’ within Impero to match each section.

e Thereis a limit of 1200 Groups to 1500 devices per Impero Server.

e To limit what the School District share with Impero ‘Sharing Rules’ are
applied within the school district portal. (We encourage Districts to only
share what they need rather than all sections.)

e Users can schedule the sync of Clever once per day.

e Group settings are maintained on existing clever groups and only user
changes are applied.
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URL: https://schools.clever.com

Example Clever District Portal which may show an invitation from Impero
(Unless already accepted via the invitation email) or alternatively Districts can
search for the Impero application and submit a request to connect.

Lo © | @ CleverInz [US] | httpsy/schools.clevercom + @ ®
5 apes Y SchocisWesk ) MGSupeat BN Euchange [ Outicck B PhiDecs B U Mal BN P Mail [ Linkeain 4 JRA BN CRM ) Moot ) Bty ] it @ EdinklAl & Hlrk @ appleDev G GoogleMM O Dashbosrd - Cwmm: G Gaogle Admin cans o
= Memw Clever #DEMO Development District Dashboard Portal @ & Julian Churchill =
iy Homs ¥ summer is coming! - - > .

Make sure you're ready by completing the year-end guide. i ‘ nd
B vear-ena Guide - - o
@ Pona

- o our auored applcatians v memD udsied sade T ooters Lo Lest 7 ey
o& Applications > e View Repert ) View Matrics  Visit Portal %
amenth age
(Z) supportToals > _
Applications Add application
(Fier:
~ Namo * Logins Iast 7 days Sharing Moxt stop
& seungs . - oo ) ) _
e i i Fix data warnings
imper. o 0 Sharing district g
8 Team
' Impero Education Pro (Dev) o T
[ 0 0 Sharing distnct Fix diata warnings
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URL: https://schools.clever.com

>Select the Impero Application

>Select Support Tools from the menu on the left
>Select the ‘Data Browser’ option
>Select the ‘Schools’ Tab under

>Select the School or schools to be synchronised with each Impero Server.

el i
& C | & Cleverinc. [US] | https://schools.clever.com/browser#{"sidebar":"schools"} . .
= Detail View
SRV A Clever W' #DEMO Development Distric S 2017-05-18T0833.27.297Z
F_(E M Ve T GEE e Schools Students Teachers School Admins Seal  high_grade 12
id I 591d5¢57c1a747921b000009 I
D Portal Data Warnings BrOWS@ SChOOIS
last_modified 2017-05-24708:55:13.2227
Applications > Login Logs location.address 350 5th Avenue
- 8 schools found
location.city New York
@ Support Tools > 1
| location.state NY
Name #J
B2 Sync I
: it 10001
-8 Y Cert Data Day 1 - City High School ccation.zip
{6} Settings 3 Cert Data Day 1- Pineapple Elementary School | low_grade 9
Cent Data Day 1- Rockaway Beach Middle School name Cert Data Day 1- City High School
= 1
&2 jleaty Cert Data Day 1- Rockaway Beach Middle School Campus 2 phone (212) 555-1212
Cent Data Day 1 - Rockaway Beach Middle School Campus 3 principal.email tdkhan@mailinatorcom
Greenleafcheesewrap principal name Theodara Khan
Pumaheneysuckle school_number 02M800
Tigerdragonfruit | sis_id 02M800
state_id 712345
-I I
links Students, Teachers, School Admins, Sections

>id refers to the ‘School ID’

>
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Please Note: Impero uses the ‘Credentials.district_username’ to create the
EdPro username or if this particular box is not populated, Impero will parse the
‘email’ field using everything before the @ symbol to create a username, in
both cases this should match a user’s Active Directory credentials for log in so
that the user shows as logged in within Impero EdPro.

(to ensure you do not exceed the maximum.)

This page helps to determine which schools they wish to import (Sections
(Impero Groups) must not exceed 1200 in total per Impero EdPro server including
existing groups already in EdPro)

<« C | @ Clever Inc. [US] | https;//schools.clever.com/browser#{ | B8

B8 O -Mail BE PM-Mail [ Linkedin ¥ JRA EE CRM [ Hotlist @ Bity IJ Insight (@ EdinkUAT (@ Edlink & AppleDev G GooglelAM G Dashboard - Chrome G Google Admin cons:

£ Apps [0 SchoolsWeek @ MG Support B

= Menu Data Browser Clwer W #DEMO Development District Dashboard Portal e Julian Churchill [
£, Home Data Wamings Schools  Students  Teachers Student Contacts
BER YearendGuide  Login Logs Browse Schools
[ Portal
8 schools fourd
] a
& Applications 5

Name
Support Tools 3
Cert Data Day 1- City High Schoo
F‘A Sync Cert Data Day 1- Pineapple Elementary School
Ce ool
6% Settings
0 >
o Cent | Campus 2
2 Ce | Campus 3
& Team ;
Gre
Pu
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This page helps determine the number of sections (Impero Groups) which will

be included for each school import. (1200 maximum Sections (Impero Groups)
per Impero EdPro Server)

>Select ‘Support Tools” from the menu options on the left

>Select ‘Data Browser’

>Select ‘Sections’ tab from the top of the screen

& @ | & Cleverinc [US] | https://schaal
%t apps [F Schools Week € MG Support

clever.com)/browser#{ sidebar":"sections”, filters™]) | B ®

change [ Outiook @ PMDocs BN /- Mail BE PM-Mail [ Linkedin § sRA BE CRM [E Hotlist (® Bitly (] insight & EdiinkUAT @ Edlik o AppleDev G GooglelAM G Dashboard - Chrome G Google Admin cons:

= o S Clever W 2DEMO Development District Dashboard  Portal @  Julisn Churchill [ A
£, Home Data Warnings Schaols  Swdents  Teachers  SchoolAdmins  Sections  Sudent Contacts

B vear-end Guide Login Logs Browse Sections

j Portal

‘ Add Filte 398 sections found

m s
& Applications 5

a a . Primary
. School Name 4 Grade 4 Subject s Students
(2) SupportTools 3 TEET

2345678901234567830 Kindergaren homeroomvadvisory  oranna F
Greene

By syme

b Settings

&, Team

Using the filter options you can determine the number of sections (Impero
Groups) which can be filtered using rules which can be applied to every school

(explained later in the doc)
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The example below shows using filter options we have identified the number of
sections (Impero Groups) we could exclude using rules later i.e. you may not
require an Impero Group creating for every homeroom section.

PLEASE NOTE: This is to demonstrate to the end user only and these must not
be applied, ALL filters must be applied by the end user in their dashboard.

&« @ | @ Clever Inc. [US] | https;/schools.dever com/browser#{"sidebar"sections”, filters™{["field_list"{ "course_name"."course_number”,"grade”,id","name”."period" "school" "sis_id"."subject” "term.name"] "deletable™true ‘cmp_list*["equals”,"contains" "does not ec #r | [l ®

3 apps [ SchoolsWeek @ MGSupport BN Bxchange [P Outiook @ PMDocs BN C1-Mail BN PM - Mail Linkedin § JRa % CRM [F] Hot ® Bitly () Insight & EdiinkUAT ¢§ Edlink # AppleDev G GooglelaM G Dashboard - Chrom: G Google Admin cons:

= Menu | Data Browser Clever #DEMO Development District Dashbosrd  Portal @  Julian Churchill 1

‘.‘ Home Data Warnings Schools Swdems  Teachers  School Admins  Sections  Studemt Comtacts

R vear-end Guide

Browse Sections

m Portal I
m% Applications >
(&) SupportTools [ grade - “ equals b || 12 x | |
B Sync 40 sections found
{{‘”‘ Settings >
£y Team School Name 4 Grade; Subject %+ Primary Teacher  Students
gf.:ogﬁta Day 1- City High AP Art History - 404 - R. Plant (Section 1) 12 social studies Robin M Plant 20
Cert Data Doy 1-City High AP Calculus - 403 - R. Will (Section 3 12 math Roger J Wi 25
gf.:ogﬁta Day 1- City High AP Chemistry - 404 - M. Kulas (Section 3) 12 science Mallie S Kulas 20
© tlementary Schoot Toecnon 2) © Harns
Cen Data Day1- City High School G858 102, H 102-R Rickie C
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Clever District Sharing rules page please use the links below to learn how to use
‘Sharing Rules’ to restrict the number of Groups created in Impero Education
Pro.

To Share all schools and all sections select the ‘Share by District option’

€ C | & Clever Inc. [US] | https:/schools.dever.com, ¥ < | B B
i agpr [ SchosisWeek @ MG Suppore BE Exchenge [ Ouiosk B MDocs B8 C1-msil BE PA-Mail [ Unkedin § %4 BE CRM ) Hotlst () By [] irsght & EnUST 9 Edlimk & AppleDev G Gosgle M G Dsstboswd -Chrome G Google Admin cons
= Menu Clever W #DEMO Development District Dashboard  Poral ] Julian Churchill §1

£ Home

- Impero Education Pro

rview  Daia Validatior Deta Sharing

Choose a sharing type Back

mg Applications. 3  Toleam more about sharing data with applications,
=
(@) SupportTools > Share by Rules .
o
want 1o create rules which will dynomically share students. sections andior teachars with this application.
By syn
Share by Sections
want 1o select individuol se: lication. S
— , ont to sekect ol ssct oplicat o
This will include 1eachers of i
& Tea
Select
Share by District Select
Iwant 0 share all students, teachers, and sections in my district with this applicetics
School Site Sharing
Select
vent school site admins 1o shere students, sections andor taachers with this applicetior

District Sharing Rules (Advanced) - Video

https://www.youtube.com/watch?v=yhho8 YPRRk

District Sharing Rules (Basic) — Video

https://www.youtube.com/watch?v=QpcKOUmPe94

Clever Support Portal — Contains a range of advice and resources.

https://support.clever.com/hc/en-us

Please note: There is no phone number for Clever support and users must
complete an online form in the first instance.
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https://support.clever.com/hc/en-us/requests/new

Please, follow these steps to complete this process.

1. Login to the Clever portal as a District Admin at
https://schools.clever.com/

2. Open a new tab within the same browser.

3. Copy and paste the following URL into the new tab:

https://schools.clever.com/signup/impero-education-pro
4. Authorize the Impero App:
a. Check the, | authorize Clever to share this information with
Impero check box.
b. Choose Authorize App.

5. Set the appropriate Data Sharing scope for your Clever instance.
Available options include Share Entire District, Share by School, Share by
Section, and Share by Rules.

Please Note: We recommend using the ‘Share Entire District’ as the
Impero Application supports configuration on a school by school basis.

6. After you have selected the appropriate Data Sharing scope, check the
confirmation check box listed below the option selected, and then
choose Save Changes.

7. Capture the District and individual school IDs of Clever for use in Impero
Setup:

To find the ‘District ID’, click the menu in the left pane

> ‘Support Tools’

> ‘Data Warnings’, and copy the district id from the URL

e.g. 5435453 from ‘https://schools.clever.com/warnings/5435453’
To find the ‘School ID’, click the menu in the left pane

> ‘Support Tools’

> ‘Data Browser’, click the school to capture and copy the id
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>Launch the Impero Education Pro Server Application
>Select the ‘Settings’ Tab

>Select the ‘SIS Integration’ Tab

>Input the Clever ‘District ID’

>Input the Schools or ‘School ID’

File » Tools ~ Help ~

—— - = — — : N B ,
E::“ Licence [ Connections [ﬁ’ Setlings [% Automatic Updates ”E‘?‘ Patch Management [v Room Booking [’3 Confide 4

[Active Directory Settings\'(_ Resource Logging X Console Access Rights { Mail Server Settings” ( Acceptable Use pD”C): X __Computer Availability f Group Timetablea*,»
Lock Screen (Misc \(pin Group Set'tings‘.“l Insight ’(ﬁui!t-ln Groups \[SISInbgaﬁm \

' #DEMO Education Pro QA District
|

I nsert school Id

5 | Name ; |_ | Import
5925504267 15b42a1200000f Tigerdragonfruit ‘_lv. ‘ Import Groups

[C] Scheduled daily import

Last import time 08/09/17 13:4523

Lastimport status ~ WARNING: 1 user(s) were not imported due to having no username and no email

| o ‘ Remove all Clever groups and schools

By Selecting the + Button the secure connection between the Impero Server
and Clever is established.

By Selecting the ‘Import Groups’ option, a synchronisation of Clever ‘Sections’
to ‘Impero Groups’ is undertaken.
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New ‘Clever Group’ users are not immediately visible within a group in the
Impero Console, once a user has logged in for the first time they will then show
greyed out until they have logged in.

[ (=] [=)[@][#][] [z -] (%) (2] [ [¥][& [s==:--
‘I'én Removable Media Disabled (0/0) o Computer | User | Captures Active Blocks
Q_l, Screens Locked (0/0)
&b Sound Muted (0/0)
B cheese(0/0)
B Log OFF (7/7)
B Maria Test (9/11)
& 0sGroup (252/499)
B Power OFF (2/3)
B Smoke Computer (2/3)
£h Advanced PI —
%Advanced;—'\l i Add
&h Advanced pl; = Remove
%Advanced Pl{ = Rename
*{é, Economics 1
&h Spanish 2103
% user group |

Actions [

Import Directory Groups

< BB BuiltIn Block List r
@ Captures Allow List
& Alerts

Keyword Detection

Advanced Policies (SIS W L ive Thumbnails

]

Q@ B mHE G e =

0 computers ticked R Limit: 100. W an Limit: 1000 xpiry Date: 1 8 AHepl v .

An SIS import will create a group for ALL Clever sections imported and a
‘Console Access Rights’ user for ‘Teachers’ and a user for all ‘Students’ as per
the import.
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Clever Import groups are a ‘Medium’ priority by default.

Advanced Algebra 2 1(4) 2(6) 3(7) 4(1) 52| User

Member Name

[Add Mew Member]

|iohr1 paul.anderson.2435| |Username E' |Cle\rer import
|zoeey white 246056 | |Username E' |GE“’EV import
|e1han.thomas.243139 | |Username E' |03\f3fimport
|isabella.anderson.25?35| |Username E' |Cleverimpon
|madison.garda.261?33| |Username E' |Cleverimpon

Removal Date

Currently all groups created using an SIS Import have all ‘Group Access Rights’
as a default.

e Jock Zildes I
?_‘:‘ licznt(z Jj_g Cond'éctian‘si =] sn.w{g Automatic um@ Patch Managémen}' I .

Lock Screen (Misc \(Pin Group Settings ((nsight (Buitt-In Groups (SIS Integration

Define who can use Impero here. Access rights can be granted to users, computers or active directory groups. A¢
one access right applies to the same person.

(®) Allowed To View Group and

7] Only allow the following users,computers and Active Directory groups to access Impero

The Password needed to run the console (if full access is enabled OR if a specified computer is 12 Maﬂ&g e Grou P Members
given access to Impero)

. Manage Group Policies
[ Require all console users to enter the password once per session. (Highly recommended securii
o] ] | Manage Classroom Layout
Access Rights List (5) |Access | Groups | Policies| . ag }l’

% Chils Set the group access rights for simon ManaEIE 'Gr':"UF" .F'H:C €55 H'I-g htS
cree

& ghaythomthwaite Existing Groups (48)

it i Manage Group Settings
& simon 3 340 “| | @Allowed T
e A 2 Rename Group
. [ Manage;
3 Animals 1(M1,W1 F1,72TH2)
& Animals 2(M1,W1,F1,72,TH2) gm"”e Delete Grou o]
3 Animals 3(M1,W1,E1,72,TH) m:::: .
99 Ancther Grou .
Lindoini et (C) Mo Access To Group
99 chris 7] Delete Gr
9 Chrome Ext Test | ©NoAcy
:

Currently ALL changes made here will be overwritten during the next
Synchronisation. Please Note: This will updated in our next release.
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Impero have in built Data warnings for when specific Data is missing from a
synchronisation.

When data is missing from either of these fields
Student email doesn't exist

Student username doesn't exist

Teacher email doesn't exist

A ‘warning’” will appear in the Impero Server Application.

File » Tools ~ Help ~

& Licence Connections ﬁ’ Settings . 4 Automatic Updates ‘ﬂ“ Patch Management \, v Room Booking x‘.& Confide 4 »

Active Directory Settings ( Resource Logging A Console Access Rights\ f Mail Server Settings l' Acceptable Use Policy ( Computer Availabilit',;\ ( Group Timetable ™,
Lock Screen Misc ‘(Pin Group Settings ““_lnsight ‘[?uilt-ln Groups "{SISlnbgﬁiot;

Clever

59254c0F196c26000157F11F | #DEMO Education Pro QA District
[Imser‘. school Id | +

D | Name 1 | — ‘ Import

5925504a67 15b42a1a00000f Tigerdragonfruit ‘ & ( Import Groups

[Z] Scheduled daily import

Lastimporttime  14/09/17 12:4546

A Last import status  WARNING: 1 user(s) were not imported due to having no username and no email L

Last import status ~ WARNING: 1 user(s) were not imperted due to having no username and no email

|

TR T te]er

Apply

.I ‘ I o | Remove all Clever groups and schools
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To identify the specifics to a data warning the end user can access this
information from within their schools portal

https://schools.clever.com

>Select the Impero Application

‘Data Warnings’ are highlighted at the top of the page

Cle\er W #DEMO Development District Dashboard  Portal )

Impero Education Pro

Qverview Data Validation Data Sharing Instant Login Licenses

Next step: Distribute login information to 103 teachers so they can access Impero Education Pro.
Status Launch Date Sharing Settings Last Modified
Launched Jun-08-2017 Jun-08-2017

Your data has warnings on 2 student fields and 1teacher field. Warnings indicate that the students and teachers you have shared may not appear correctly in Impero Education Pro.

Your data has warnings on 2 student fields and 1 teacher field. i

Users can download a CSV containing the fields that are affected in order that a
correction can be made within the SIS in question.

Alternatively, we can access the same information from within our Clever portal
shown below

= Meu Clever ¥ impero Education Pro Search for a district

£& Home
Data Browser

O #DEMO Education Pro QA District

Lost ync: 6 days ago Last shring updte: 080812017 SHARED SCHOOLS LaUNCH DaTE
Sync: running Sharing all data 8 (licenses not set) Jun 8, 2017
all; Metrics
Overview Sharing Filters. Users :
» Warnings
Dev Tools >
Sissues found % Notify district
4% settings
Data Errors
& Team Users and sections marked by data errors will not be sent to the application.
Name Count csv
E; Billing
Data Requirements
Users and sections that do not pass an application’s data requirements will not appear properly in the application.
—— — csv k
Data Warnings
Users and sections that shew warnings for an application may be incorrectly shared or have a degraded experience in the application.
Name Count 4 csv
Student username doesn't exist 10 & Download
Teacher email doesn't exist 4 & Download
Student email doesn't exist 3 & Download
A
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District Admin Guides

https://support.clever.com/hc/en-us/categories/200147297-District-Admin

List of ‘Clever-managed auto-syncs’ and ‘SIS-managed auto-syncs’

https://support.clever.com/hc/en-us/articles/202114723-Self-Service-Guide-
Secure-Sync-Rostering-#securesync

District Sharing Rules (Advanced) - Video

https://www.youtube.com/watch?v=yhho8 YPRRk

District Sharing Rules (Basic) — Video

https://www.youtube.com/watch?v=QpcKOUmPe94
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info@imperosoftware.com

wWwWw.imperosoftware.co.uk

WWW.imperosoftware.com
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